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These release notes cover: 

New features added to Xara Xtreme Pro 3.2 since version 3.0 

 

Bitmap & Photo Handling Improvements 

Zoom 

Document Scrolling 

Color Handling 

Fill Handling 

Vista Compatibility 

Key Shortcut Changes 

Copy / Paste to / from Microsoft Word 

Right Drag Copy 

Easy Rotate 

New Import and Export Options 

Text Tool 

New Templates 

Other Miscellaneous Changes 
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Bitmap and Photo Handling Improvements 

External Photo Editors 
Xara Xtreme now integrates with external photo editors. Xtreme still contains the 

Xara Picture Editor (XPE) as the default photo editor, but is now also bundled with 

an alternative MAGIX photo editor. 

 

What's more there is now UI to allow you to select not just whether XPE or the 

MAGIX photo editor is used, but to call any external editor.  Xara Xtreme monitors 

the photo file being edited, and detects when it's updated by the photo editor and 

then re-imports it back into Xtreme. So this should allow integration with many third 

party photo editing solutions.  This is completely asynchronous. So you can continue 

to have your photo editor open and work on the drawing in Xtreme. Whenever the 

image file is updated from your photo editor (when you click save), Xtreme re-

imports it and updates your drawing. So you can just continue working on your 

photo in your photo editor, and every time you click save - Xtreme automatically 

updates to show you the new picture in context. 

 

You can now edit both photos and photos inside shapes (bitmap fills) just by double 

clicking on the photo or shape. 

 

One of the consequences of editing photos in external editors is that the bitmaps are 

expanded from JPG format into raw (PNG) bitmaps so that the editing process is 

lossless. This means that editing photo images with external editors will enlarge .xar 

files, possibly quite considerably. This does not apply when using the XPE editor.  

 

 
You can now choose the default photo editor 
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A new ‗Editing Bitmaps‘ option has been added to the Options dialog, Effects & Plug-

ins tab, where you can choose to use XPE or an external bitmap editor. 

 

Photo Drag and Drop 
We‘ve made significant improvements to drag ‗n drop handling of photos. You can 

now drag a photo from either the galleries (bitmap, fill or clipart) or a photo file 

dragged from your File Explorer over any existing photo (be it a stand-alone photo 

object or a photo 'fill' inside a shape) and it will be replaced. This works for photos 

inside shapes and even inside groups. The photo is now resized to best fit the 

container. The best way to illustrate the benefit of this new feature is to just drag 

and drop alternative photos onto some of the new template designs. It is now 

trivially easy to replace photos with alternatives.  The Fill tool is automatically 

selected after you drop a bitmap this way to make it easy to manipulate. 

  

One consequence is that if you want to drag and drop import a photo, and don‘t 

want it to replace an existing photo, then you should now drop it on the 

background away from any existing photo, or hold Shift down when dropping it 

  

Another change is that dropping photos onto normal shapes no longer works the 

same way. To fill normal shapes with the photo (or bitmap), you now have to hold 

the Shift key when you drop the bitmap. 

  

Photo Resize, Rotate and Push 
When you drop a photo onto a shape to replace the existing one it is sized to just fill 

the visible shape. You can resize and rotate the image by dragging the ends of the fill 

arrow (the correct aspect-ratio now remains locked when you do this).  You can 

push the picture around inside the shape by dragging on the center fill handle, 

anywhere on a fill arrow or by holding Shift and dragging anywhere on the photo 

  

If you hold Shift while dragging the ends of the fill arrow it will stretch / skew the 

bitmap. Holding Ctrl will constrain the angles. 

 

 
Resize and rotate the fill by dragging the ends of the fill arrows 

Push the fill by dragging anywhere on the fill arrow 
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Bitmap Fill Replacement 
If you drag and drop fills from the fill gallery - these continue to operate under the 

old rules. (You can drag and drop a fill onto any shape to fill it, and it becomes a tiled 

fill, and uses different sizing rules). 

Zoom 

We've enhanced the scroll wheel zoom (hold down Ctrl) so it's much smoother, less 

flickery and faster. For those that prefer to have the scroll wheel zoom always, 

there's a new option (Options dialog, Mouse tab) to make the scroll wheel 

always zoom in and out, rather than document scroll (useful if you're working on 

photos a lot or single page documents).   

 

 
You can set the mouse wheel to scroll the document or zoom 

 

In combination with scroll wheel press (to pan documents) this provides a really 

efficient, keyboard-less way to zoom and pan around your documents. 

 

Document Scrolling 

We've also enhanced the document scrolling using the mouse wheel to make it 

accelerated. So scrolling through larger documents is now a lot quicker and more 

efficient. 

 



 

 

5 
 

Release 

Notes 

Color Handling 

There have been significant changes to the way colors are handled.  The old template 

based selection of primary colors has gone and been replaced by a 'Standard Palette' 

of 46 pre-defined colors. There are 5 shades of 7 standard hues and 10 shades of 

gray, black and white. 

 

 
 

Standard Palette colors, like PANTONE Colors or other library colors are not 

editable (i.e. they are not Named Colors) and are designed as a simple, 

limited selection of colors to apply to objects (either by dragging onto the object or 

clicking). 

  

The old ‗web browser palette‘ has been switched off (no longer relevant or useful 

since 256 color screen modes are no longer used). It remains in the Color Gallery if 

you want to enable it again. 

 

Named Colors 
In older versions of Xara Xtreme, a new Named Color was created and added to 

the color line whenever you created a new color. This typically resulted in dozens of 

Named Colors appearing in the line, even though most of them weren't actually 

used. This no longer happens. When you create any color (e.g. click one of the 

Standard Palette colors) it just applies that as a local color to the object. You can of 

course edit this color using the Color Editor as always (Ctrl+E). Only if you select 

the 'New Named Color' icon in the color editor is a new Named Color created.  

 

Automatic Removal of Unused Colors 
When you save and load files, all unused Named Colors are now removed from the 

color line. This results in a much, sometimes very much, simpler and cleaner color 

line. 

  

If you want Xara Xtreme to work the old way un-check the 'Delete unused colors' 

option at the bottom of the View tab of the Options dialog. 

 

Linked Colors 
Linked colors (that is ones tied to a parent, such as a tint or shade) are 

now represented differently on the color line (smaller rounded rectangles), so it's 

much easier to distinguish which are normal independent Named Colors and which 

are linked to a parent. 
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Right Click on Color Line 
There is now a context menu that gives access to the most common color 

operations. 

 

  
Context sensitive right click menu on the color line 

 

So the old right click to set line color has been removed. You can still Shift+Click to 

set a line color and this is now the recommended way to set line colors (or use right 

click and the menu option). 

  

Right clicking on the ‗no color‘ patch produces a slightly altered menu; with 'clear line 

color' and 'clear fill color'. 

 

  
Right click menu on the ‘no color’ patch 

 

Re-ordering Colors 
You can now just drag a Named Color on the color line to re-position it. 

 

You can restore the 

old right-click 

behaviour of setting 

the line color, using 

an option in the 

View tab of the 

Options dialog. 
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Smart Line Coloring 
It was always confusing to new users why they could draw a simple line, click a color, 

and nothing happened (because that sets the fill color not the line color). So we‘ve 

made it smart and it can now detect whether the shape is open or closed. A left click 

will now set the line and fill color of an open path (i.e. of an unfilled shape). 

Shift+Click can continue to be used as before. 

 

Bitmap Contoning 
If a bitmap or a bitmap filled shape is selected, then the right click context menu on 

the color line allows you set the contone colors as well as the line color. 

 

 
Contone a photo by right clicking on the color line 

 

If a shape is filled with a bitmap (photo) then clicking on the color line will contone 

the shape filled with a bitmap (instead of converting it to a flat filled shape as it used 

to in older versions). So this is now consistent with the behavior of real bitmap 

objects. 

 

Fill Handling 

Adjusting fill positions 
As you know the single click-and-drag method of creating graduated fill and 

transparencies remains a key benefit of Xara Xtreme. We've now added the ability 

to push the fill (retaining the relative positions of the end points) within the shape. 

You can either just drag anywhere on the fill arrow - the whole arrow moves, or 

hold Shift while dragging anywhere on the fill.  So now with a single click-drag you 

can set the start, end and angle, and another click re-positions the fill as required. 
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Move the fill by dragging on the fill arrow 

 

•  When dragging on the ends of the fill arrows (or transparency fill arrows) it now 

preserves the aspect ratio of the fill. Hold Shift to squash or skew the fill. 

•  It‘s now easier to find fill handles. In other words we've increased the hit radius 

when dragging near the ends of the fill arrows, making it less fiddly to adjust the 

ends. 

 

Automatic Select Inside 
In the fill tool we‘ve made a significant change in that it now automatically selects 

shapes inside groups. This means it‘s significantly easier to view and edit the fill style 

of shapes. In the fill tool, just click on any shape, in a group or not, and it will select 

the shape and show the fill arrows (assuming it‘s not flat filled). Drags will now adjust 

the fill of that shape as usual. 

  

Combined with the new push fill feature, this means it‘s now significantly easier to 

manipulate fills of shapes. 

 

Vista Compatibility 

This release is now fully operational under Windows Vista e.g. it can be used from 

non-Admin accounts (on both Windows XP and Vista). 

 

Key Shortcut Changes 

•  Holding down space bar now does a temporary switch into the Push tool. 

Releasing it returns to the previous selected tool. Or, pressing it once will switch 

to the Push tool, pressing it again will return to the previous tool. 

•  Plain numeric 1, 2, 3, 4 set the zoom to be 100% to 400%.  Number 5 key sets it to 

be 50% (The old shortcuts on these keys have been moved to Ctrl+Shift+1, 2 etc) 

•  Ctrl+W closes the current document, as is becoming an industry standard 

shortcut. 
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If you wish to restore the old use of the Space Bar as a shortcut to the Selector tool 

you can do so with the Shortcuts utility that‘s included with Xtreme Pro.  Start the 

utility and select Tools on the left. Then select the ‗Switch to Selector‘ (default 

shortcut of Alt+S) and choose ‗Space‘ from the keystroke list. 

 

Some other recent key shortcut changes include: 

• Ctrl+Shift+R shows or hides the rulers 

• V selects the Selector tool 

• T selects the Text tool 

• Z selects the Zoom tool 

• G selects the Fill tool 

• H selects the Hand (push) tool 

• L selects the Ellipse tool 

• M selects the Rectangle tool 

• N selects the Freehand tool 

• W selects the Blend tool 

• Q applies ClipView to the selected objects 

• Alt+Q removes a ClipView 

 

There are a large number of new key shortcuts in the Text tool—detailed below. 

 

Copy / Paste to / from Microsoft Word 

You can now copy ‗rich text‘ (as it‘s sometimes known) from other applications such 

as word processors or editors and paste into Xtreme, and the fonts, margins and line 

spacing will be preserved. This makes it dramatically easier to retain the style and 

appearance of your text.   

  

When you paste ‗Rich Text Format‘ from other applications you are given the choice 

of pasting the text in as ‗Unformatted Text‘ which means it will appear in the font 

and style at the cursor where you paste, or Rich Text Format which means it will 

retain the style of the source text. 

 

 
Cut & paste from Microsoft Word 
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This also works the other way around. You can copy text in Xtreme and paste into 

other applications that support rich text editing and the style (font, size, colors, 

margins etc) will be retained.  This will only work if you select and copy a single text 

object or from a single text flow. 

 

Some applications, such as Microsoft Word, have a 'Paste Special' menu option that 

provides a wider range of paste options. These applications will sometimes allow you 

to choose the format of the pasted object (text or graphic). 

 

Right Drag Copy 

Copying objects on your page is a very common operation when creating graphics, 

and Xtreme now makes this easier than ever before.  In the Selector tool if you 

right-drag (that is you hold the right mouse button, instead of holding the left mouse 

button while you drag) then the object will now be copied instead of moved. 

 

What‘s more, while dragging (with the right mouse button help down), each time 

you click the left button (requires slightly unusual mouse handling) a copy of the 

dragged object is dropped at each click.  

  

Easy Rotate 

To accompany the new easy ways of copying objects there‘s now an easier way to 

rotate objects without having to go into Rotate mode. 

  

Whereas before, you had to click on an object with the Selector tool to toggle 

between resize mode and rotate mode, now if you‘re in resize mode (the normal 

mode) if you hold the mouse-pointer just inside the corner selection handles (see 

illustration) then the pointer changes to indicate that dragging will now rotate 

instead of resize. 

 

 
 

You can still click 

on the Rotate icon 

on the Selector 

InfoBar. 
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So now you can resize and rotate all objects on the page without having to toggle 

between rotate and resize mode. 

 

The old method remains (i.e. clicking again to go into Rotate mode) or click the icon 

on the Selector tool InfoBar. 

 

New Import and Export Options 

The new export options appear in the drop-down list of export types on the Export 

dialog (click the ‗Save as type‘ drop down as usual). 

 

These file conversion options are provided by a system of plug-in filters, that can 

easily be updated independently of Xara Xtreme. It is expected that these import / 

export options will continue to be enhanced, and other new options will be provided 

in future. 

RTF - Rich Text Format 
See above (copy/paste to/from Microsoft Word).  You can now import and export 

text in RTF format so it includes style information such as font, font size, color, 

margins, special and foreign characters (Unicode supported). 

EMF - Extended Metafile Format 
There is now support for EMF import, a vector graphic format supported by many 

modern Windows applications. WMF import has also been enhanced.   

RAW Photo Import 
You can now import (either using the Import menu option or just drag n drop the 

file onto the Xtreme window) RAW digital camera files.  

SVG Export 
A new SVG export option is available. This is not complete, but can be used to 

export basic vector graphics into SVG format. This plug-in will continue to be 

enhanced.  

XPS – XML Paper Specification 
This is an entirely new ‗page description‘ file format invented by Microsoft. Designed 

for Vista this is also supported on older versions of Windows by way of a free XPS 

Viewer download from the Microsoft website (Google for XPS Viewer EP). The 

benefit of XPS format is that it‘s vector based, and so is ideal as a resolution-

independent portable document format. Fonts are embedded into the document and 

so you are assured of a very high quality WYSIWYG document.  If you‘re using 

Windows Vista you can view and print these document directly. 

 

It should be noted that the Xara XPS export does not use the Microsoft standard 

XPS print system, but writes XPS files directly which ensures a far higher fidelity, and 

far smaller XPS files. 
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XPS supports advanced vector features such as transparency, CMYK colors and 

embedded fonts. 

 

 
XPS export dialog 

Font Subset 

Any fonts used in your document are automatically embedded into the XPS 

document to enable the viewer to correctly display all text. Selecting this option 

embeds fonts containing only those characters used in the document. This can 

significantly reduce the XPS file size. 

 

View XPS when finished 

This will automatically open the XPS viewer and display the saved file. 

 

Rasterization 

XPS is a vector format, but it doesn‘t support some of the advanced effects, fill and 

transparency types supported by Xara. Files containing, for example, objects with 

feathered edges will result in that object being rasterized, that is converted into an 

alpha-channel bitmap. The resolution of this rasterization process is controlled by 

these fields. 

 

Resample JPEG images 

JPEG photo images contained in an Xtreme file are usually embedded as the full 

resolution original JPEG file (and is thus a lossless process). However for many 

applications this might be overkill. E.g. a typical modern digital camera can easily 

create a 4Mbyte JPEG file, 3000 pixels across or more. If this is placed on the page in 

Xara and scaled to be say 2 inches across, that photo would be at a resolution of 

more than 1500dpi – way more than is required for any printing application. (The 

resolution of bitmap objects is shown on the status line in Xtreme). 

 

You can therefore choose to resample JPEG photos to a lower resolution more 

suited for viewing on screen (e.g. 96dpi) or printing (typically not more than 300 

dpi)., and thus reduce the size of the XPS file. The JPEG quality slider controls the 
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quality of the resampled JPG. The lower the quality the smaller the resultant XPS file. 

A quality of 75 is the recommended setting, which is actually a very high quality 

image. 

 

Color Mode  

XPS files, like Xtreme documents, can contain a mix of both RGB and CMYK colors. 

However the XPS viewer shows CMYK colors as color corrected for the printer. 

Xtreme on the other hand shows all colors (CMYK and RGB) as screen colors or 

printer colors (depending on the Show Printer Color menu option). This slightly 

different approach to displaying colors can result in significant differences between 

RGB and CMYK versions of the same color. In Xtreme, for example, cyan is shown 

as the same color on screen whether it‘s been defined as CMYK or RGB. XPS 

displays the same color completely differently. 

 

Selecting the RGB colors option will force all colors to be converted to RGB to 

provide consistency with the way Xtreme displays colors. Selecting Native colors will 

export objects using whichever color model you‘ve used in Xtreme, but this will 

likely result in color changes where you‘ve mixed RGB and CMYK colors in the same 

document. 

 

Text Tool 

There have been a large number of improvements to the text tool: 

Smart Quotes 
When you type a quote ' or double quote " characters Xtreme will automatically 

convert these into the more appropriate and aesthetically accurate opening or 

closing quotes. So this changes 'this' into ‗this‘ and "quotes" into ―quotes‖. It‘s 

smart enough to understand the use of single quotes within words to signify missing 

characters, so that 'don't' becomes ‗don‘t‘. 

Guideline When Dragging Tabs and Margins 
In the Text Tool when you drag the margins or tabs on the ruler, you now get a 

temporary vertical guide to make it easier to align the tabs or margins to objects 

elsewhere on the page. 
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In addition when dragging tabs or margins, if you have magnetic snap switched on, 

these will snap to each other making it easier to position tabs and margins. 

 

Soft and Hard Hyphens 
If you type Ctrl+- (minus key) it inserts a soft hyphen which is a hyphen that only 

appears if the word can wrap at the end of a line. This is particularly useful for 

narrow columns of text where, to avoid rivers of white, you might need to 

hyphenate some words. Inserting a normal dash character will split the word at the 

end of the line.  Here‘s an example where there is too much space between words 

on the top line because the word ‗hyphenate‘ doesn‘t quite fit. 

 

 
 

If you type Ctrl + - after the word ‗hyphen‘ then it breaks the word at that point and 

produces a more satisfactory word spacing. 

  

It‘s called a ‗soft‘ hyphen because when the word appears in the middle of a line the 

hyphen vanishes (unlike a normal dash or minus character), so it intelligently 

hyphenates the words only if it needs to. 

  

When editing the text a soft hyphen is treated as an invisible character (it takes no 

space), but you can tell it's in the text by moving the cursor left/right over where the 

invisible character is. 

  

A hard hyphen can be inserted by typing Ctrl+Shift+ - (minus key). A hard hyphen is 

one that will not cause a wrap at all. This is useful in situations where you have 

dashes in words that you do not want split at the end of lines. 

 

Paragraph Spacing 
Two new fields on the end of the Text tool Infobar allow you to set the spacing 

above and / or below paragraphs. This is particularly useful where you want half line 

spaces between paragraphs. 
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 Set the space above & below a paragraph 

 

Like Microsoft Word if you use both spacing above and below paragraphs, the 

spacing between paragraphs is whichever is the greater value (it‘s not cumulative).  

Paragraph spacing above paragraphs will move the 1st paragraph down in a frame of 

text. 

  

Paragraph Select 
A quad click - that is four rapid clicks in a row - is now a shortcut to select a 

paragraph. This is an extension of the existing standards: 

    Single click - positions cursor 

    Double click - selects word under cursor 

    Triple-click - selects line 

    Quad-click - selects paragraph 

 

Word Count: Text Tool Status Line 
The status line now reports how many characters and words are within the 

selection, or, if there's no selection, how many are within the whole of the current 

text story. This updates continuously as you type. 

  

 
Word and character count on the status line 

 

Optimized Text Placement 
If you just click and type (i.e. create a simple text object), the position of the type is 

adjusted very slightly, by fractions of a pixel, to ensure that the baseline of the text 

exactly sits on a pixel boundary. This results in sharper, more readable text at small 

point sizes and 100% zoom view (depends on the font and point size). But for 

example the default 10pt Arial or Arial italic is now noticeably less blurred for simple 

text objects. 
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Lorum Ipsum 
When creating page layouts, it‘s common practice to use dummy text, which is a 

type of pseudo-Latin (it doesn‘t really mean anything), but has the overall appearance 

of typical English text (or other similar Latin-based languages).  The text starts 

‗Lorem ipsum dolor sit amet...‘.  (In fact this same text has been used as dummy text 

going back more than 500 years in the print trade, and parts of the actual Latin used 

can be traced to text written more than 2000 years ago). 

 

You can now insert a paragraph of the Lorum Ipsum text by typing Ctrl+Shift+L (L 

for Lorum) when in the text tool. To insert a larger block of text just press the key 

combination a few times. 

  

Swap Case 
Pressing Ctrl+W will swap the case of the character after the cursor, and move the 

cursor on.  So if you find you‘ve accidentally typed a section of text with the Caps 

lock key on, just place the cursor at the start and press and hold Ctrl+W. This has 

now been enhanced so that you can swap the case of a selected region of text in the 

same way. 

 

Increase / Decrease Text Size 
New shortcuts of Ctrl+Shift+> and Ctrl+Shift+< will increase or decrease the point 

size of the selected text or selected text story (only if the selection is all the same 

point size). This is compatible with Microsoft Word. 

  

Manual Kern Key Changes 
The old kern shortcuts of Ctrl + and - have changed. (Ctrl+ - is now the soft 

hyphen). 

The new kern shortcuts are Alt+ left and right arrow keys. 

So to move two characters closer together press Alt+ < and to move them further 

apart press Alt + >. Each key press moves the character 50/1000 ems. 

These shortcuts are compatible with Adobe Illustrator. 

 

Special Characters 
A number of useful shortcuts have been added to allow insertion of special 

characters: 

Hard space:       Ctrl+Space (words with hard spaces between will not wrap at 

the end of a line) 

EN dash:   – Ctrl+NumPad – (An EN dash is longer than a minus, and is a 

more correct ‗dash‘) 

EM dash:   —  Ctrl+Alt+NumPad -  (An EM dash is a long dash) 

Ellipsis: … Ctrl+Alt+.  (That‘s with a full stop or period character.  An 

Ellipsis is three dots …) 
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Copyright: ©  Ctrl+Alt+C 

Registered ® Ctrl+Alt+R 

Trademark ™ Ctrl+Alt+T 

Bullet  • Ctrl+Alt+B 

 

All the above shortcuts (with the exception of the hard space) are compatible with 

Microsoft Word.  

 

New Templates 

A large collection of new top quality editable templates have been added,  including 

more greetings cards, newsletters and calendars, plus new categories such as photo 

albums and collages, newspapers, documents, certificates and coupons.  You can find 

them in the Clipart Gallery. 

 

 
Xtreme templates include cards, newsletters and photo albums 

 

 

Other Miscellaneous Changes 

Freehand Tool Change 
A small change is that the ‗hit radius‘ around the end of lines has been increased, 

meaning it‘s much easier to append lines to the end of others, and easier to draw 

closed shapes (so they will be filled with color). 

 

Editing Rounded Corner Rectangles 
Rounded corner rectangles can now be resized in the rectangle tool (including aspect 

ratio changes) while maintaining circular corners. Resizing in the Selector tool will 

still permanently transform the corners so they are not circular, as before. 

 

Click on the 

Clipart Gallery 

icon to access the 

resources in the 

Clipart Gallery 

 

 
 

Click the ‘Get 

Clipart’ button to 

download some 

web-based clipart  

examples. There 

is a much wider 

range included on 

the CD. 
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Retain rounded corners by  

resizing in the rectangle tool 

 

MAGIX Photo Manager 
If you have MAGIX Photo Manager and have any photo edits saved for your 

photos (e.g. if you‘ve adjusted the brightness, contrast etc) then you can load the 

associated .jpx file and Xara will show the image with the correct processing. 

 

 

The following changes were made after the original Xara Xtreme Product Manual 

went to print and so this section should be treated as an erratum to that manual.  

 

Coordinate Direction 
You can now change the direction of page coordinates so that, for example, Y values 

increase as you go down the page. This is useful when you want the 0,0 point to be 

the top left corner and increase down the page like it does for HTML. These new 

options are on the Grid & Ruler tab of the Options dialog. 

 

Zoom 
Most digital camera photos will be too large to fit on the page, so Xtreme now 

automatically zooms out when you import a photo, so the whole image is instantly 

visible.  You can return to the previous zoom by clicking on the previous zoom 

button on the standard button bar. 

 

 
previous zoom 

 

A new '100% zoom' operation has been added to zoom toolbar (visible when you are 

using the zoom tool). 

 

 
100% zoom on the zoom toolbar 
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Name Gallery Improvements 
The Name Gallery now shows more detail on the fonts used in a document, using 

the full font name as shown in the font gallery. It also shows variations of a font as a 

separate selectable font name, as well as the font family (e.g. Arial Bold, Arial Italic, 

Arial Regular). It shows at a glance which fonts have had to be synthesized and which 

are not installed. 

 

 
 

Print Dialog Improvements 
The Print dialog has been completely re-designed, the layout is now more intuitive. 
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Document Info Dialog Improvements 
The Document Information dialog (File > Document Info) has been re-designed, the 

new layout is more intuitive. 

 

 
 

 

 

Line Width 
Line width is now shown by default in pixels if the page unit is set to pixels. You can 

change this in Utilities > Options > Units. 
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Animation Frame Gallery 
The Animation Frame Gallery order has been reversed, so it now shows the first 

frame at the top. 

 

 
 

 

Errata 
For a list of errata in the Xara Xtreme Pro manuals please visit: 

http://www.xara.com/support/xtreme/manual 

If you find an error or omission we would appreciate it if you inform us via the above 

URL. 

 

http://www.xara.com/support/xtreme/manual
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Systems Incorporated in the United States and/or other countries. MAGIX is a 

registered trademark of MAGIX AG. 

 

 


